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Change History 
 

Document Version Changes 

1.7 Updates to reflect changes introduced in ICE Risk Model Software version 1.3.0.6: 

WFPRCAP - This version the option to cap the Weighted Futures Price Risk 
(WFPR) for a given ICE Risk Model Combined Contract within an inter-contract 
spread to be the minimum value of the scanning ranges applicable to any 
contract within that ICE Risk Model Combined Contract. This is controlled via a 
menu option that can be enabled/disabled by the user. The WFPR capped value 
is now reflected also in the Intercontract Spread report which now reports both 
the uncapped and capped WFPR values (ICS Report) 

Output of Positions resulting from Position Allocation – A new menu option 
allows user to request that the positions created as a result of the Position 
Allocation process be written out to an output file; this is intended to assist in 
understanding the allocation process and to support users developing their own 
software. 

Value Losses Data File – A new VL.CSV data file can be generated (VL Report). 
This is a data file providing a breakdown of value losses for each contract position; 
this is intended as an aide to analysing scanning losses. This contains the same 
information as the SVL report in a data format. 

Enhanced support for NYSE Liffe margining 
Method 02 Inter-Contract Spread – This version implements fixes to the 
computation of Method 02 Inter-Contract spread credits. Method 02 spreads are 
utilised for certain Liffe products and this now means that ICE Risk Model fully 
supports calculation of Liffe contract margin. 

Results Data File – The Results Data file (Results.csv) generated by ICE Risk 
Model now includes the Exchange Id in order to better support margins 
calculated for Liffe portfolios with 3 exchanges – “L”, “O” and “X”. 

NOTE that ICE Risk Model allows multiple Array files to be loaded at the same time 
allowing margin to be calculated across portfolios spanning multiple exchanges at 
the same time. 

1.8 Apply changes to embedded URLs in order to link to updated ICE web site. 

1.9 Updated the document to reflect the ICE’s rebranding of our risk management 
offerings to ICE Risk Model (IRM). The current 
implementation is not changing; this is merely a rebranding of ICE’s risk 
management offerings. 

Removed references to SP5 which has been previously deprecated. 

2.0 General review and update. 

3.0 Inclusion of model assumptions, limitations, and more granular details on 
methodology 
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1. Introduction 
 
This document describes ICE Futures and Options IRM® Margin Model (“IRM”) and information on 
the related technical details to replicate the model’s output.  
 
ICE Clear Europe’s (the “CCP or Clearing House”) Futures & Options (“F&O”) uses IRM to calculate 
the core Initial Margin (“IM”) requirements for each F&O Clearing Member (“CM”). 
 
If you have questions relating to any of the content presented in this document, or IRM more broadly, 
please contact: 

• ICEU ICE Clear Europe Risk team at ICEClearEurope-FORisk@ice.com or +44(0)20 
7065 7630  

• ICUS ICE Clear U.S. Risk team at ICEClearUSRisk@ice.com 

• ICSG ICE Clear Singapore Operations team at 
ICEClearSingaporeOperations@ice.com 

• ICNL ICE Clear Netherlands Operations team at 
ICEClearNetherlandsOperations@ice.com or + 31 20 3055164. 

 
Note that the majority of this document applies equally to the calculation of margin for cleared Energy, 
Financials and Softs (“F&S”), and OTC FX contracts. Where different approaches are applicable, 
these are highlighted. 

mailto:ICEClearEurope-FORisk@ice.com
mailto:ICEClearUSRisk@ice.com
mailto:ICEClearSingaporeOperations@ice.com
mailto:ICEClearNetherlandsOperations@ice.com
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2. Model purpose and business context 
IRM is a scenario-based and parameterised risk model used to evaluate the risk exposure to the 
Clearing House in the event of a defaulting portfolio. 
 

2.1. Non-technical model summary 
IRM calculates IM requirements for each clearing member’s portfolios. IRM captures market risk 
through the identification of the outright, calendar spreads and calendar strategies as well as pairs 
of positions with potential diversification benefit.  
 
IRM is used to calculate IM requirements overnight for collection the following morning. IRM is 
additionally used for intraday risk management to calculate intraday IM, a key input in the potential 
intraday margin calls. 
 

2.2. Assumptions and Limitations 
The main assumptions and limitations of IRM model are:  

• The default IRM setting is 16 scenarios for the calculation of the Scanning Risk, as defined 
in section 3.2: the set of price and volatility movements to 16 scenarios to estimate the risk 
related to futures and options contracts.  

• IRM assumes multiple scenario conditions to calculate the Scanning Risk: scanning 
components are calculated based on worse PnL from the 16 scenarios at logical level and 
then aggregated, effectively mixing various scenarios PnL in the aggregation logic. 

• Margin parameters used within the IRM algorithm are calibrated using models relying on their 
set of assumptions. Please see https://www.ice.com/clear-europe/risk-management, Initial 
Margin Overview section, for details. 

• In order to estimate the IRM Option’s Price Risk under the 15th and 16th scenarios (i.e., only 
the extreme underprices are shocked, as described in section 3.1), it is assumed that an 
Option’s PnL move can be approximated with the first order Greeks risks (delta, vega and 
theta) and the second order gamma risk.  The higher order risks related to volatilities (i.e., 
Volga) are not accounted for. It should be noted, however, that these can be limited for the 
Vanilla Option’s PnL explanation. 

 
3. Model Theory and Approach 
This section describes the F&O IRM methodology, providing details of how the underlying Genbat 
and Marbat processes operate to achieve the IRM IM calculation.  
 
3.1. Model Overview 

The F&O IRM model estimates the IM requirements of portfolios per currency and requires 2 different 
processes sequentially: Genbat which produces instrument Risk Arrays and Marbat which produces 
the portfolio IRM IMs.  
 

3.1.1. Genbat and the Risk Array 
 
Genbat applies the IRM margin parameters and rates to top day settlement prices to generate the 
Risk Arrays used for margining in the Marbat process.  
 
Risk Arrays are calculated by revaluation of contracts under scenario changes to underlying price, 
volatility and time. This Risk Array is a key input to the next process, Marbat. 
 
Genbat generates the IRM Risk Array file and is arranged following a hierarchy of data records: 
 

• Record Types from 10 to 16 that define the common data. Where IRM is used in a multi-

https://www.ice.com/clear-europe/risk-management
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market (multi-exchange) environment, these records define data that is common across this 
environment (for example inter contract spreads that traverse multiple markets). 

 
• Record Type 20 defines an Exchange (Market) and acts as a “grouping” for all the records. 

All records (Types 30, 40, 50, 60) that follow record 20 are defined within the context of the 
Exchange record. 

 
• Record Type 30 groups in respect of a Combined Commodity. The record types from 31 to 

36 define specific tiers and spreads relating to the Combined Commodity. Following this, 
then, the Risk Arrays themselves (Record 60, Series Details) are defined within a hierarchy 
for each Contract (Record 40) and Contract Expiry (Record 50). 

 
 

3.1.1.1. Record 15: Scenario definition 
 
The record 15 of the Risk Array contains the definition of the set of 16 scenarios later used in the 
record 60, which contains the PnLs calculated for each individual instrument (or contract) during the 
Genbat process.  
 
These 16 scenarios are a set of price and volatility shocks designed to represent hypothetical market 
moves. 
 
The scenario settings are reported as below in the Risk Array. Note that the Risk Array does not 
contain any headers within the file: 
 

Record Type ID Short  description Paired scenario 
15 1 F+0/3, vol+ 2 
15 2 F+0/3, vol- 1 
15 3 F+1/3, vol+ 4 
15 4 F+1/3, vol- 3 
15 5 F-1/3, vol+ 6 
15 6 F-1/3, vol- 5 
15 7 F+2/3, vol+ 8 
15 8 F+2/3, vol- 7 
15 9 F-2/3, vol+ 10 
15 10 F-2/3, vol- 9 
15 11 F+3/3, vol+ 12 
15 12 F+3/3, vol- 11 
15 13 F-3/3, vol+ 14 
15 14 F-3/3, vol- 13 
15 15 F+Extreme 15 
15 16 F-Extreme 16 

Table 1: Extract of the Risk Array Record Type 15.  
 

The scenarios are based on nine price variation possibilities: 
 

• No variation 
• Price increase or decrease of 1/3 of the Scanning Risk parameter  
• Price increase or decrease of 2/3 of the Scanning Risk parameter 
• Price increase or decrease of 3/3 of the Scanning Risk parameter. 

 
For options these price changes are combined with the forward moving of one day, and two variations 
to the current volatility: 

 
• Volatility shifted up by a percentage which is the upshift parameter 
• Volatility shifted down by a percentage which is the down shift parameter. 
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As an example, under scenario ID 7, futures or underlying (F) are shocked up (+) 2/3 or 66.6% of 
the future or Underlying IRM scanning range. It is combined with a Volatility Up (+) shift as defined 
per the volatility up shift IRM parameter (as defined in the Record type 50).  
 

3.1.1.2. Record 60: Series Details 
 
Assuming the definition of the scenario detailed above, the Risk Array contains all the PnLs 
calculated for each individual instrument (or contract) during the Genbat process. These 16 PnLs 
are stored in record type 60. 
 
Genbat combines the information reported in the below IRM input files to compute these PnLs. 

• Products Definitions 
• Pricing Models (refer to the F&O Pricing models for further details) 
• Scenarios 
• Dividends and Interest Rates 
• Contracts details and Settlement prices 
• IRM Parameters (margin rate parameters) 

 
An example record type 60 is represented below, where a positive amount in Table 4 indicates a 
loss and a negative value indicates a gain. 
 

Field name Value IRM input file origin 
Record Type 40 Genbat construct field 
PCC 0AC Product 
Contract Type F Product 

Description 
0AC-Aristocrat Leisure Ltd 
(Flex Div Adj Future Cash) 

Product 

Currency AUD Product 
Tick Denominator 10000 Product 
Minimum Price Fluctuation (in ticks) 1 Product 
Tick Value 0.0001 Product 
Delta Divisor 1000 Product 
Decimal Locator 0 Genbat configuration 
Strike Denominator 0 Genbat configuration 
Scanning Range (in ticks) 17402 IRM Parameter 
Settlement Style Method 2 Product 

Table 2: Extract of the Risk Array Record Type 40. 
 
 

Field name Value IRM input file origin 
Record Type 50 Genbat construct field 
Expiry 20180222 Contract and Settlement 
Discount Factor 1 IRM Parameter 
Vol Up shift 0.25 IRM Parameter 
Vol Down shift 0.25 IRM Parameter 
Number of expiry Group 1 IRM Parameter 
Expiry group 1 20180222 Contract and Settlement 
Expiry Group 2   

Table 3: Extract of the Risk Array Record Type 50. 
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Field name Value IRM input file origin 
Record Type 60 Genbat construct field 
Strike Price 0 Contract and Settlement 
Contract Type F Product 
Lot Size 1000 Contract and Settlement 
Settlement Price 239226 Contract and Settlement 
Composite Delta 1 Genbat output 
Loss Value 1 0 Genbat output 
Loss Value 2 0 Genbat output 
Loss Value 3 -5801 Genbat output 
Loss Value 4 -5801 Genbat output 
Loss Value 5 5801 Genbat output 
Loss Value 6 5801 Genbat output 
Loss Value 7 -11601 Genbat output 
Loss Value 8 -11601 Genbat output 
Loss Value 9 11601 Genbat output 
Loss Value 10 11601 Genbat output 
Loss Value 11 -17402 Genbat output 
Loss Value 12 -17402 Genbat output 
Loss Value 13 17402 Genbat output 
Loss Value 14 17402 Genbat output 
Loss Value 15 -12181 Genbat output 
Loss Value 16 12181 Genbat output 
Table 4: Extract of the Risk Array Record Type 60. 

 
 

3.1.2. IRM Portfolio Positions 
 
IRM is designed such that a unique set of margin parameters are stored at the Logical Commodity 
Code level (‘LCC’) with each Physical Commodity Code (PCC) being mapped to an LCC. For 
example, Brent products will all be classified under LCC:BRN, which includes, inter alia, Brent futures 
contracts PCC:B and PCC:I. Where PCC:B is the standard future, and PCC:I is the 1st Line future. 
These 2 contracts will use the same IRM margin parameters as they have the same underlying risk 
factor. 
 
Genbat collects data about options and futures positions grouping them under their respective LCC, 
expiries (as IRM allows a Discount Factor called SCRAF Ratio to discount the headline scanning 
range to be applied along the term structure1) and strikes. These are reported sequentially in the 
Risk Array from record type 30 to 60. 
 
IRM portfolios are represented by PCCs grouped at LCC level. Table 5 below shows the composition 
of a synthetic portfolio considered as an example. It contains futures and options on different 
underlyings, referenced to different LCCs and PCCs. 
 
The future positions with physical code B represent ICE’s deliverable contract on Brent Crude futures 
(logical code: BRN); the futures with physical codes SYS and SZS refer respectively to a future on 
Fuel Oil 380 CST Singapore (logical code: SYS) and to a future contract on Fuel Oil 180 CST 
Singapore (logical code: SZS); the call option with physical code PHE refers to Henry Penultimate 
Fixed Price Future (logical code: HNG). 

 
1 Futures and Options contracts tend to be more volatile at the front of the curve. Allowing a single scanning to represent the full 

curve, especially using the most conservative rate along the curve, could be inappropriate for contracts at the back of the curve. 
See section on SCRAF Tiering in the following page. 
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Logical  

Code 
Physical Code Position Expiry Date Strike 

Price 
Quantity 

BRN 
 

B F 20171100 0 1 
B F 20171200 0 -2 
B F 20180100 0 1 
B F 20181000 0 1 
B F 20190300 0 -1 

SYS SYS F 20171000 0 1 
SZS SZS F 20171000 0 -1 
HNG PHE C 20171200 3200 -10 

Table 5: Composition of a synthetic portfolio. 
 

 
3.1.3. Marbat and the Initial Margin Components 

 
Marbat applies the Risk Arrays to Clearing Member positions to determine their potential losses, as 
detailed in the following section. 

 
3.2. IRM Margin calculation 

 
IRM Initial Margin (also referred to as ‘Original Requirement’) is comprised of several Intermediate 
Risk components. This section focuses on the individual calculation method for each of these.  
 
In summary, the Intermediate Risk components are: 

• Scanning range (Scan) - capturing outright or directional risk; 
• Strategy spread (SS) - capturing risk of delta-neutral strategies (e.g. butterflies and condors); 
• Inter-month spread (IMS) - capturing calendar spread risk; 
• Spot charge (SC) - capturing reference price risk; 
• Inter-contract spread (ICS) - capturing the risk offset between pairs of correlated instruments. 

 
The IRM Initial Margin is the sum of the final risk of each Combined Commodity where the final risk 
is the max of the summed Intermediate Risk components and the Short Option Minimum, a minimum 
requirement held against short option positions. 
 
In addition to the calculation of the Initial Margin and its components, this section outlines IRM 
concepts such as Net Deltas and Tiering structure. 
 

3.2.1. Scanning Risk 
 

The first risk component calculated in Marbat is the Scanning Risk. It is calculated for each position 
of the portfolio and produced at the LLC level and represents the outright or directional risk.  
 
The Scanning Risk considers the Risk Array PnL vector (the 16 scenarios PnLs) of each individual 
contract. The scenario PnLs are multiplied by the IRM delta position of each instrument or contracts 
added up under each scenario, producing a Scanning Risk IM at the LCC level.  
 
Marbat identifies the worst-case loss across the aggregated 16 scenarios at the LCC level and the 
largest loss is called the Active Scenario. If two scenarios have the same figure, the one with the 
lowest scenario number is the Active Scenario. Where the Scanning Risk amount is negative (i.e. it 
corresponds to a gain) or zero (no risk), the Scanning Risk amount is set to zero. 
 
Note that if a SCRAF Tiering is defined for an LCC, a discount factor (or SCRAF Ratio) can be applied 
to the different maturities on the IRM Delta. See section 3.2.8 for further information on SCRAF 
Tiering. 
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Figure 1 is an example of the reported the PnLs of Brent Futures positions from Table 5 above for 
each future contract with different maturities. It illustrates that the Scanning Risk for these Brent 
futures shows no net losses or gains as the PnLs of opposite positions are equal and opposite in 
every different scenario (note these maturities belong to the same SCRAF Tier). 
  

 
Figure 1: Report of PnLs of Brent Futures, calculated by IRM for ICE. 

 
Figure 2 displays the Scanning Risk for Henry Penultimate Fixed Price Future at the LCC level, in 
which for the PHE call option, the largest loss occurs under scenario 11 at $2660. 
 

 
Figure 2: Scanning Risk report for Henry Penultimate Fixed Price Future. 

 
 

3.2.2. Introduction to Net Delta 
 

IRM aggregates IRM Deltas of futures and options for a given LCC into Net Deltas per tiers (SCRAF, 
IMS or ICS tiers - see section 3.2.8) in order to analyse calendar spreads not considered in the 
Scanning Risk. 
 
Estimated position delta is given by the weighted average of the deltas produced at each of the 16 
underlying price points in the Scanning Risk, and it is called IRM Delta. The Loss Covered 
percentages (i.e. Loss of a scenario over maximum loss for a given contract) represent the weights 
to compute the weighted average of options Delta. 
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The option delta is calculated by using the settlement prices and implied volatilities of each clearing 
day. By convention, for a call contract, delta is valued between 0 and 1, and for a put contract between 
–1 and 0. By definition, delta for future contracts is always equal to 1. 
 

The calculation of the Net Deltas ∆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎,𝑚𝑚 for a specific LCC, portfolio ‘a’ is performed at the most 
granular level aggregating all delta positions expiring with the same expiry month ‘m’ by: 
 

∆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎,𝑚𝑚= �𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,𝑒𝑒.∆𝑃𝑃,𝑃𝑃𝑃𝑃𝑃𝑃,𝑒𝑒.𝐶𝐶𝐶𝐶𝑃𝑃𝑃𝑃𝑃𝑃,𝑒𝑒.𝐷𝐷𝐷𝐷𝐿𝐿𝐿𝐿𝐿𝐿,𝑒𝑒

𝑘𝑘

𝑒𝑒=𝑖𝑖

   (1) 

where 
 

𝑒𝑒   Expiries within the expiry month m  
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃,𝑒𝑒   Number of Position of the PCC (under the LCC) with expiry 𝑒𝑒 

∆𝑃𝑃,𝑃𝑃𝑃𝑃𝑃𝑃,𝑒𝑒  Delta of the PCC with expiry 𝑒𝑒  
𝐶𝐶𝐶𝐶𝑃𝑃𝑃𝑃𝑃𝑃,𝑒𝑒  Contract Size (Or Lot Size) of the PCC with expiry 𝑒𝑒 
𝐷𝐷𝐷𝐷𝑃𝑃𝑃𝑃𝑃𝑃,𝑒𝑒 Discount rate (SCRAF Ratio) of the LCC for the expiry 𝑒𝑒. 

 
Table 6 below considers all the relevant information to calculate the Net Deltas for Brent futures in 
Table 5 portfolio. It also considers a discount factor to apply on the deltas. Net Delta values are 
reduced to four decimal points. 
 
 

Physical Code  Position Month Position Delta Size Discount Rate Net Delta per expiry 
B F 20171100 1 1 1 1×1×1=1 
B F 20171200 1 -2 1 1×(-2)×1=-2 
B F 20180100 1 1 1 1×1×1=1 
B F 20181000 1 1 78.79% 1×1×0.7879=0.7879 
B F 20190300 1 -1 78.79% 1×(-1)×0.7879=-0.7879 

Table 6: Net Deltas for Brent futures from Table 5 portfolio. 
 

Table 7 below illustrates Net Deltas for other positions from portfolio in Table 5. 
 

Physical Code  Position Month Position Delta Size Discount rate Net Delta per month 
PHE C 20171200 0.5 -10 88% 0.5×(-10)×0.88=4.4 
SYS F 20171000 1 1 95.45% 1×1×0.9545=0.9545 
SZS F 20171000 -1 -1 95.45% (-1)×1×0.9545=-0.9545 

Table 7: Net Deltas for other position from Table 5 portfolio. 
 
 
3.2.3. Spreads Calculation 

 
The following methodology is common to Strategy spreads, Inter-month spreads and Inter-contract 
spreads:  
 

i. Calculate Net Position Delta 
The IRM Parameter file used in Genbat defines various strategy combinations and an order of spread 
priorities combinations. Genbat reformats the information in the Risk Array and maps actual contracts 
(Top day expiries) to the relevant set of strategies. Therefore, the Risk Array contains an explicit 
definition of strategies (i.e. combination of contracts). 
 
The Risk Array record type identifying the spreads are: 

• Record Type 31: Defines the Tiering, as per the IRM Parameter file map, to current contracts 
(from contract and settlement file), mapping expiries to tiers 

• Record Type 32: Defines the leg spreads, i.e. the portfolios relating to the spread definition. 
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• Record Type 34: Defines the Inter-contract spread Tiering (applied to ICS) 
• Record Type 35: Defines the actual Strategy spreads of actual contracts. 

 
Spreads are identified depending on the available Net Delta positions in the tiers. If there is Net Delta 
available for the first legs of the spread, the spread direction is determined. Each spread consumes 
Net Position Delta, and each iterations consumes the remaining Net Position Delta until there is no 
more Net Position Delta available for spreads consumption. 
 
The ordering is defined as follow: 

1) Strategy spreads, following the Strategy spread order 
2) Inter-month spreads, following Inter-month spread order 
3) Inter-contract spreads, following the Inter-contract spread order. 

 
ii. Identify Spreads  

From the relevant expiries identified within the tiers, Marbat identifies the number of Spreads at the 
LCC level for a given portfolio as the minimum absolute value between the Net Delta per 
representative expiries as calculated previously (equation 1) such that: 

 
𝑆𝑆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎
𝑖𝑖,𝑗𝑗 = Min��∆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎,𝑖𝑖�, �∆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎,𝑗𝑗��  (2) 

 
If  

𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆�∆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎,𝑖𝑖� = −𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 (∆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎,𝑗𝑗) 
where 
 

𝑆𝑆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎
𝑖𝑖,𝑗𝑗    Spread between expiry i and expiry j 
∆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎,𝑖𝑖  IRM Net Delta of the LCC for expiry i 
∆𝐿𝐿𝐿𝐿𝐿𝐿,𝑎𝑎,𝑗𝑗  IRM Net Delta of the LCC for expiry j. 

 
Note that spreads are identified following a priority order (cheapest to most expensive) and Net Delta 
positions not consumed are kept for next priorities spreads until there are no more Net Delta positions 
available for spreads. 
 

iii. Calculate Spread Charges 
Calculate the charge amount for the Spreads of each priority by multiplying the number of determined 
spreads by the associated spread charge rate. 

 
 

iv. Calculate the remaining Net Position Delta 
Remove the Net Delta used for the calculated spread from the pool of available Net Delta for each 
tier. If there is a remaining Net Delta, it must be retained for further use. 

 
 

3.2.4. Strategy Spreads 
 
Strategy Spreads are used to identify delta-neutral combinations of positions such as butterflies and 
condors. Where available, the Strategy spread is calculated prior to the Inter-month spread. The 
Strategy spread calculation is based on several parameters that are available in the Risk Array with 
record type equal to 35 which contains: 

• Strategy spread priorities 
• The charge (or rate) per spread  
• The total number of legs in the spread (for a Butterfly it is expected to have 1 Leg 1st month, 

-2 Leg middle month and 1 Leg last month, note the positions can be of either side i.e. -
1,2,-1). 
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For each leg the following information is provided: 

• The expiry  
• The SCRAF Ratio 
• The market-side indicator (‘A’ or ‘B’). 

 
The market side indicator or Leg side is related to the sign of the Net Delta to form spreads. In case 
that legs are in the opposite sides, for example Leg1=A and Leg2=B then for the spread to be formed 
it is necessary that Net Deltas have opposite signs. In this case, if Leg A is long (positive) than B 
must be short (negative). If legs have same signs, for example Leg1=A and Leg2=A, this implies that 
also Net Deltas must have the same signs. The leg definition should always meet the following: 
 

sign(A) = −sign (B)  (3) 
 
From the Risk Array at record 35 the following information displayed in Table 8 is available for the 
Brent products.  
 

Priority 1 2 … 63 … 151  … 
Charge 550 1 … 38 … 50  … 
Number of Legs 4 4 … 3 … 3  … 
Expiry1 20171000 20171100 … 20221200 … 20171100  … 
SCRAF ratio 1 1 … 1 … 1  … 
Market Side1 A A … A … A  … 
Expiry2 20171100 20171200 … 20230100 … 20171200  … 
SCRAF ratio 3 3 … 3 … 2  … 
Market Side1 B B … B … B  … 
Expiry3 20171200 2018010 … 20230200 … 20180100  … 
SCRAF ratio 3 3 … 3 … 1  … 
Market Side1 A A … A … A  … 
Expiry4 20180100 20180200 … 20230300 …    
SCRAF ratio 1 1 … 1     
Market Side1 B B … B     
Table 8:  Risk Array record 35 for Brent. 

 
 

Step 1: Calculate Net Position Delta for each maturity month 
To calculate the Strategy spread charge, initially the Net Position Delta availability should be assured 
for the legs of the spread. If there is, i.e. the Net Delta for the maturity date is not zero, then it is 
possible to calculate the Strategy spread: 
 

Inter-month Tier Month Long Net Delta Short Net Delta 
2 20171100 1  
3 20171200  -2 
3 20180100 1  
7 20181000 0.7879  
7 20190300  -0.7879 

Table 9: Net Deltas. 
 
 

Step 2: Identify Strategy spreads for the combined contract  
Spreads are processed by following the Risk Parameters file’s priority order. Considering a synthetic 
portfolio, a Butterfly strategy is identified for Brent Futures at priority 151: 
 

Priority … 151  … 
Charge … 50  … 
Number of Legs … 3  … 
Expiry1 … 20171100  … 
SCRAF ratio … 1  … 
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Market Side1 … A  … 
Expiry2 … 20171200  … 
SCRAF ratio … 2  … 
Market Side1 … B  … 
Expiry3 … 20180100  … 
SCRAF ratio … 1  … 
Market Side1 … A  … 
Expiry4 …    
SCRAF ratio …    
Market Side1 …    

Table 10: Butterfly spread for Brent. 
 
The next step is to pass through all legs to establish the amount of Net Delta that can be consumed. 
In the below example for the 20171100 expiry, there are 1.000 long Net Deltas, for 20180100 there 
are 1.000 long Net Deltas and for 20171200 there are 2.000 short Net Deltas. 
 

Tier Month Long Net Delta Short Net Delta 
2 20171100 1  
3 20171200  -2 
3 20180100 1  

Table 11: Net Deltas table. 
 

The number of possible spreads is equal to: 
 

𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁 𝑜𝑜𝑜𝑜 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 = 𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀 ��
1.0000

1
� , �
−2.000

1
� , �

1.0000
1

�� = 1,000   (4) 
 

 
Step 3: Calculate the Strategy Spread Charge 
The Strategy spread charge for priority equal to 151 is: 
 

𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 𝐶𝐶ℎ𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 = 1.000 (spreads)x 50 (spread charge) = $50. 
 

Therefore, the Strategy spread charge is $50 as it is calculated by IRM below 
 

 
Figure 3: Strategy spread calculation in IRM. 

 
 
Step 4: Calculate the remaining Net Position Delta 
Finally, the consumed Net Delta from the first Strategy spread is deducted from the available Net 
Delta on each tier. The remaining delta is kept for other identified Strategy spreads until none is left 
available for strategy consumption. 
 

Tier Month Net Delta per month Strategy consumes Remaining Delta 
2 20171100 1 (1×1)=1 0 
3 20171200 -2 (1×-2)=-2 0 
3 20180100 1 (1×1)=1 0 
7 20181000 0.7879  0.7879 
7 20190300 -0.7879  -0.7879 

Table 12: Remaining Net Delta. 
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In this case, no other spreads were identified for other instruments in the portfolio. The unused Net 
Delta will remain to identify any Inter-month spreads. 
 
 

3.2.5. Inter-month Spread 
 
IRM identifies calendar spreads risk via Inter-month risk. The margins applied are calculated at LCC 
level and are called Inter-month spread charges. All parameters are specified in the margin 
parameters table named Intermonth Spread rates and in the IRM Risk Array in records type equal to 
32 which contains: 

• Priorities and SCRAF tiers  
• Charge (or rate) 
• Number of legs. Each leg consists of three components. 

 
For each leg there are: 

• Tier Numbers 
• SCRAF ratios 
• Market Side (same as Strategy above) 

 
Priority 1 … 9 … 36 … 64 
Spread Charge Rate 90 … 381 … 318 … 1951 
Number of legs 2 … 2 … 2 … 2 
Tier Number 3 … 7 … 3 … 2 
SCRAF ratio 1 … 1 … 1 … 1 
Market Side A … A … A … A 
Tier Number 3 … 7 … 7 … 11 
SCRAF ratio 1 … 1 … 1 … 1 
Market Side B … B … B … B 

Table 13: Risk array example of record 32. 
 
 
Step 1: Calculate Net Delta per tier 
To calculate the Inter-month spread charge, the unconsumed Net Position Delta after the Strategy 
spread charge processing is used. The Net Deltas are now aggregated per inter-month tier as 
represented below for the Brent portfolio example: 
 
 
 
 
 
 
 
 

 
 

Table 14: Remaining Net Delta. 
 

Spreads will be effectively formed if there are available positions in the tiers, presenting both the 
Long Net Delta and the Short Net Delta. 
 
 

Step 2: Identify spreads 
From the Risk Array file, the Inter-month priorities are defined, and below is an illustration for BRN 
LCC. Priority 1: Inter-month spread charge for priority 1 is represented by tier combination 3 / 3.  
 

Inter-month Tier Long Net Delta Short Net Delta 
1 0 0 
2 0 0 
3 0 0 
4 0 0 
5 0 0 
6 0 0 
7 0.7879 -0.7879 
… … … 

https://www.theice.com/publicdocs/clear_europe/spanParameters/PublishCalendarSpread.xls


ICE Risk Model (IRM) Model and User Guide 

- 17 - 

 

 

 
Priority 1 … 
Spread Charge Rate 90 … 
Number of legs 2 … 
Tier Number 3 … 
SCRAF ratio 1 … 
Market Side A … 
Tier Number 3 … 
SCRAF ratio 1 … 
Market Side B … 

Table 15: Inter-month Spread charge. 
 
Considering the priorities, tiers referring to the market sides A and B must have non-zero Net Deltas 
in order to be consumed for Inter-month. As per the previous Brent example, Net Deltas for tier 3 have 
already been consumed to produce a Strategy spread charge and therefore no Inter-month spread 
exist for this Inter-month combination. 
  

SCRAF Tier Long Delta Short Delta 
1 0 0 
2 0 0 
3 0 0 
… … … 
   

Table 16: Example of a spread with zero deltas. 
 
Following the priority order, it can be seen that there is non-zero Delta at priority 9. For Priority 9 the 
Inter-month spread charge is represented by the tier combination 7-7: 
 

Priority … 9 … 
Spread Charge Rate … 381 … 
Number of legs … 2 … 
Tier Number … 7 … 
SCRAF ratio … 1 … 
Market Side … A … 
Tier Number … 7 … 
SCRAF ratio … 1 … 
Market Side … B … 

Table 17: Inter-month Spread charge details. 
 
 

Step 3: Calculate the IMS Spread Charge 
The number of Inter-month spreads is determined by comparing the absolute value of the total long 
Net Delta of tier A to the absolute value of the total long Net Delta of tier B and by selecting the 
minimum absolute value between the two. For the tier 7, there are 0.7879 long Net Deltas and 0.7879 
short Net Deltas 
 
 
 
 
 

 
 

Table 18: Long and Short Net Deltas. 
 
The number of possible spreads is equal to:  
 

𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁 𝑜𝑜𝑜𝑜 𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼𝐼ℎ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 = 𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀 ��
0.7879

1
� , �
−0.7879

1
�� = 0.7879  (5) 

 

Inter-month Tier Long Delta Short Delta 
… … … 
6 0 0 
7 0.7879 -0.7879 
… … … 
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Step 4: Calculate the IMS Charge 
The Inter-month spread charge for priority 9 is equal to: 
 

𝐼𝐼𝐼𝐼𝐼𝐼 𝐶𝐶ℎ𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 = 0.7879 (spreads) x 381 (spread charge) = $300.1899 
 

Therefore, the Inter-month spread charge is $ 300 as calculate by IRM. 
 

 
Figure 4: Inter-month Spread calculation in IRM. 

 
 
Step 5: Calculate the remaining Net Position Delta 
Finally, the Net Delta has been consumed for BRN and no other spreads can be formed for this 
Combined Commodity. Based on the example portfolio there are no other Inter-month spreads 
identified for the other instruments. 

 
 

SCRAF Tier Remaining Long Delta Remaining Short Delta 
1 0 0 
2 0 0 
3 0 0 
4 0 0 
5 0 0 
6 0 0 
7 0.7879  - (-0.7879×1) =0 -0.7879  - (0.7879×1) =0 
… … … 

Table 18: Remaining Net Delta. 
 
 

3.2.6. Inter-contract Spread 
 

Inter-contract spread considers two opposite positions of different LCCs which, defined together as 
a portfolio, generate lower charge than adding up the individual LCC Scanning charge. These 
portfolios are defined in the F&O IRM Parameter calibration, referenced in the IRM Parameter File 
input, and reported in the Risk Array as record type 14. These spreads priorities are also defined by 
decreasing credit rate (i.e. considering higher offset 1st). IRM identifies and calculates the Inter-
contract spread in a similar fashion to IMS and Strategy spreads.  

 
The Inter-contract spread is given by: 
 

ICS =  WFPR × Number of Spread × SCRAF Ratio × Credit Rate (6) 
 
To be able to calculate the ICS, IRM requires the estimation of the Weighted Future Price Risk 
(WFPR):  
 

Weighted Future Price Risk =  
Price Risk 
|Net Delta|

   (7) 

 
Where the Price Risk component is derived by decomposing the Scanning Risk, assuming option 
PnL moves can be approximated with the first order Greeks risks (delta, vega and theta) and the 
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second order gamma risk particularly in 15 and 16 scenarios, as follows: 
 

Scanning Risk =  Price Risk +  Volatility Risk + Time Risk   (8) 
 
As a first step to derive the Price risk, IRM eliminates the Volatility Risk from the Scanning Risk by 
applying the Volatility Adjusted Risk. The Volatility Adjusted Risk is given by the average of the 
Scanning Risk Active Scenario and its Paired Scenario. Active Scenario and Paired Scenario have 
the same underlying price variation, but opposite volatility variations2. This allows IRM to isolate 
Volatility Risk from Scanning Risk. To recall, the active scenario is the highest loss generated in the 
Scanning Risk.   

 
Active Scenario 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 
Paired Scenario 2 1 4 3 6 5 8 7 10 9 12 11 14 13 15 16 

Table 19: Paired Scanning Scenario. 
 

Volatility Adjusted Risk =
Active Scenario + Paired Scenario

2
   (9) 

 
By taking the average of the Scanning Risk of Active and Paired Scenarios, IRM cancels out the 
Volatility Risk from the Scanning Risk and using equation 8 and re-arranging, we obtain: 
 

Volatility Adjusted Risk =  Scanning Risk−  Volatility Risk =  Price Risk +  Time Risk (10) 
 
In order to estimate the Time Risk component, IRM takes into account the Scanning Risk scenarios 
that show no movements in the underlying price but do present opposite variations of the volatility. 
Scenarios 1 and 2 do not consider any underlying price movements but have volatility moving up 
and down. Therefore, the Time Risk is estimated as follows: 
 

Time Risk =
Scanning Scenario 1 + Scanning Scenario 2

2
   (11) 

 
The Price Risk is estimated below: 
 

Price Risk = Volatility Adjusted Risk − Time Risk     (12) 
 

Once the Price Risk component has been identified, it is possible to calculate the WFPR and then the 
Inter-contract spread. 
 
The risk parameters for the calculation of the Inter-contract Spread are available at record 14 of the 
Risk Array. They include: 

• Priorities and tiers  
• Charge rates 
• Number of legs  

 
For each leg there are: 

• Combined Commodities combinations 
• Tier Numbers 
• SCRAF ratios 
• Market Sides 

 
Priority 1 … 820 … 74899 
Charge Rate 1 … 0.98 … 0.26 
Number of Legs  3 … 2 … 2 

 
2 It assumes that the average of opposite volatility variation neutralizes this risk. 
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Combined Contract 1  GST … SYS … CTS 
Tier Number 1  1 … 1 … 2 
Spread Side 1  A … A … A 
Delta/Spread Ratio 1  1 … 1 … 1 
Combined Contract 2  GSW … SZS … PAN 
Tier Number 2  1 … 1 … 2 
Spread Side 2  B … B … B 
Delta/Spread Ratio 2  1 … 1 … 1 
Combined Contract 3  SWS … 

   

Tier Number 3  1 … 
   

Spread Side 3  B … 
   

Delta/Spread Ratio 3  1 … 
   

Table 20: Risk parameters example contained in the Risk Array. 
 
 

Step 1: Calculate long Net Delta and short Net delta per Combined Commodity 
To calculate the Inter-contract spread IRM aggregates the remaining Net Deltas of all LCC per Inter-
contract tiers: 
 

Physical Code  Tiers Expiries Long Net Delta  Short Net Delta  
HNG 1 20171200   
SYS 1 20171000 1×1×0.9545×1=0.9545  
SZS 1 20171000  (-1)×1×0.9545×1=-0.9545 

Table 21: Remaining Net Deltas. 
 
 
Step 2: Identify potential combinations 
From the Risk Array, IRM is going through the priorities and reconcile a combination of SYS and SZS 
eligible for Inter-contract Spread.  
 

Priority … 820 … 
Charge Rate … 0.98 … 
Number of Legs  … 2 … 
Combined Contract 1  … SYS … 
Tier Number 1  … 1 … 
Spread Side 1  … A … 
Delta/Spread Ratio 1  … 1 … 
Combined Contract 2  … SZS … 
Tier Number 2  … 1 … 
Spread Side 2  … B … 
Delta/Spread Ratio 2  … 1 … 
Combined Contract 3  … 

  

Tier Number 3  … 
  

Spread Side 3  … 
  

Delta/Spread Ratio 3  … 
  

Table 22: Suitable Risk Array for the calculation of an ICS. 
 
The number of Inter-contract spreads is determined by comparing the Net Delta of each participant 
Combined Commodity divided by the Delta per Spread Ratio for each leg of the priority and by 
selecting the smallest absolute value in respect of market side parameter. For the Combined 
Commodity SYS there are 0.9545 long Net Deltas and for the Combined Commodity SZS there are 
0.9545 short Net Deltas. 
 

𝑁𝑁. 𝐼𝐼𝐼𝐼𝐼𝐼 = 𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀𝑀���
0.9545

1 �� , �
−0.9545

1 �� = 0.9545  (13) 
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Step 3: Calculate the ICS Charge 
The IRM for ICE defines the WFPR as shown below: 
 

 
Figure 5: IRM for ICE WFPR. 

 
The Inter-contract spread is then calculated: 
 

ICS =  WFPR × Number of Spread × SCRAF Ratio × Credit Rate  (14) 
 

ICS =  22000 × 0.9545 × 1 × 0.96 = 20159   (15) 
 

IRM for ICE presents it as shown below: 
 

 
Figure 6: ICS calculation in IRM. 

 
 

3.2.7. Tiering 
 
Tiering is a feature which allows, for a given LCC, the application of a single margin rate across a 
bucket of multiple consecutive expiries. The margin rate selected corresponds to the highest rate 
under the LCC. 
 
Figure 8 represents a typical future term structure. The green dot represents the closing price and 
the horizontal line represents the level of variance which can be considered as a benchmark of the 
portfolio’s risk level.  
 
Tiering allows a more granular approach in the use of margin rate, commensurate with the risk. 
Applying Tiering to the below example, the higher margin rate between the first 3 expiries would be 
used for Tier 1 (covering the 3 front month expiries). The same would be performed for Tier 2 and 
Tier 3. 
 

 
Figure 81: Tiering of term structure representation. 
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3.2.7.1. Types of tiers 

 
The tiers are determined per LCC. There are three types of tier employed by IRM: 
 

1. SCRAF Tier - a bucket of consecutive maturities sharing the same scanning range 
(discount factor to scanning range). These tiers are only used in the scanning calculation. 
 

2. Inter-month Tier - a bucket of consecutive maturities which can be different from SCRAF 
Tiers definition: 

 
3. Inter-contract Tier - a bucket of consecutive maturities which can be different from 

SCRAF Tiers and/or Inter-month definition. 
 

Combined 
Commodity 

SCRAF Tier Inter-month Tier Inter-contract Tier Relative Period 

BRN 1 1 1 1 
2 2 2 2 
3 3 3 3 - 4 
4 4 4 5 - 6 
5 5 5 7 - 9 
6 6 6 10 - 12 
7 7 7 13 - 18 
8 8 8 19 - 24 
9 9 9 25 - 36 
10 10 10 37 - 54 
11 11 11 55 - 87 

Table 24: Example of Brent Tiering Definition. 
 
The relative period defines the most granular risk factor used to derive the Margin rate. Note that 
relative period corresponds to constant maturity (i.e. relative period 1 will always be the front month). 
Given the maturity dates of the Brent Futures in the example portfolio considered in Table 5, tiers 
are distributed as follows: 
 

Combined Commodity Expiry Date Relative period Tier 
BRN 20171100 2 2 

20171200 3 3 
20180100 4 3 
20181000 5 7 
20190300 6 7 

Table 25 23: Brent futures form the previous example portfolio. 
 

 

3.2.8. Positions Allocation 
 
Positions allocation (also named decomposition) is a feature applied specifically to contracts which 
IRM cannot margin directly. These contracts require decomposition into individual legs which are 
then margined individually following the method described above. The allocation is captured in the 
Risk Array as Record Type 21.  
 
The products eligible for position allocation are displayed below, with further information about the 
decomposition discussed in the following sections. 
 

• Spread contracts (Spread futures, Spread options, Calendar Spread Option) 
• Average contracts (Balmos, Erosion) 
• Mini contracts 
• First line contracts 
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• Packaged contracts (Combos) 
• Any combination of the above 
• ERIS Contracts 

 
3.2.8.1. Spreads 

 
Spread Futures 
It is possible to use position allocation to decompose the spread future in to its constituent legs.  
 
Spread Options 
This is the same concept as the spread futures, but for the options. In this case, the option 
decomposes into the underlying futures of each leg, with a delta equal to that of the option delta. A 
put will have a negative sign for the allocation compared with the call. 
 
Calendar spreads options (CSOs) 
The Calendar spread Option (‘CSO’) is decomposed into 3 legs: the 2 underlying legs of the spread 
and the CSO itself. The 2 underlying spreads are margined using the defined Scanning range and 
Inter-month rate, while the CSO is margined using its own Scanning range capturing 2nd order risk 
(i.e. gamma). 

 
3.2.8.2. Average contracts 

 
Balmos 
Balance of the month contracts are the average of the reference prices for the remainder of the 
month. Each PCC is defined per starting day and each has its own Scanning range.   
 
Daily Balmos 
Daily Balmos have 1 PCC, with separate expiry dates. They have similar configuration to daily 
contracts (generic contract type of ‘D’), but these products do not roll daily, and the expiry label is 
the start of the averaging window to the end of the month. All of the ‘dailies’ for the current month 
will then roll off together. 
 
Erosion 
These products are a simple allocation of a product onto itself with a reduced delta. This is used in 
order to capture eroding price volatility due to an averaging settlement price.  

 
3.2.8.3. Mini contracts 

 
Some contracts are identical to other contracts in every way except the lot size. In this case the same 
parameter should be used and this is defined by decomposing the mini contract onto the equivalent, 
larger contract, using a smaller ratio. 

 
3.2.8.4. First line contracts 

 
Due to the expiry mismatch in some of the regular benchmark futures contract, first line contracts are 
similar products set up to match the calendar months. In this case, each first line expiry is composed 
of two consecutive regular futures and decomposes into these accordingly. 
 

3.2.8.5. Packaged contracts   
 

Combos 
Some products trade in packages of futures (Calendars/Quarters). These combos are position 
allocated onto the constituent legs.  
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3.2.9. Spot Charge (Prompt Charge) 
 

IRM includes a spot month charge for contracts with reference price risk which covers the price risk 
between the last trade date and the final settlement price.  
 

The spot month charge is calibrated with a historical simulation model using historical price data 
between the COB last trade date and final settlement date. Spot Charge is a charge applied at the 
LCC and active before a specified number of days before expiry. This is available in the risk array in 
record type 33. 
 
 

3.2.10. Rounding 
 
IRM model applies a minimum tick value round up principle. For example, in the scanning loss 
calculation, if a loss is $10.1 and the minimum tick value is $0.5, the loss will be then $10.5. 
 
 

3.2.11. Currency 
 

IRM Initial Margin requirements are aggregated at currency level. 
 
 

3.2.12. Short Option Minimum 
 

IRM includes an additional step in Initial Margin calculation which calls for a minimum amount on short 
option positions. The Short Option Minimum charge is calculated by first summing all short Call and 
short Put net positions within the LCC. The total of short option positions obtained for the Combined 
Commodity is then multiplied by Delta Scaling Factor and the Short Option Minimum Rate defined for 
the LCC. The record type 30 of the Risk Array relates to the SOM. 
 

SOM Charge =  Short option positions × SCRAF Ratio × SOM Rate  (22) 
 
 

3.2.13. Final Requirement 
 

The final Initial Margin requirement is the sum of the final risk of each Combined Commodity, where 
the latter is defined as the largest value between the Intermediate Risk and the Short Option Minimum. 
 

Final Initial Margin Req.  =  � Max (Intermediate Risk, SOM)  
𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿

 (23)  

 
Intermediate Risk is the sum of all the risk elements calculated above for each LCC. 
 

Combined Contract BRN HNG SYS SZS  
Currency USD USD USD USD  
Scenario 0 11 13 11  
Scanning Risk 0 2660 20999 20999  
Strategy Spread Charge 50 0 0 0  
Inter-month Spread Charge 300 0 0 0  
Spot Charge  0 0 0 0  
Inter-contract Credit 0 0 -20159 -20159  
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Short Option Charge 0 10 0 0  
Intermediate Risk at Combined Commodity level 350 2660 840 840  
Final Risk at Portfolio level     4690 

Table26: Intermediate Risk calculation based on the example portfolio. 
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4. Technical requirements 

All market participants and users, as well as others with an interest in understanding how ICE Clear 
margins its products, can download the IRM software. 
Users are required to accept the terms of the license as part of the installation process. Users are 
not charged for use or download of the software, but there are limitations to using the software in 
commercial applications. 
IRM utilises the Microsoft .NET Framework, version 3.5. Users must install this software prior to 
installing IRM. 
The technical details are:  

• Windows Server 2003; Windows Server 2008; Windows Vista; Windows XP, Windows 7 
(32bit and 64bit), Windows 10 (32bit and 64bit) 

• Microsoft .NET Framework version 3.5 

• 400 MHz Pentium processor or equivalent (minimum); 1GHz Pentium processor or equivalent 
(recommended) 

• 96 MB Memory (minimum); 256 MB Memory (recommended) 

• Up to 500 MB of available hard disk space may be required (including .NET) 

• 800 x 600, 256 colours Display (minimum); 1024 x 768 high colour, 32-bit Display 
(recommended) 

 
 
5. Installation Process 
IRM can be downloaded from the Risk management section of the ICE website: 
https://www.ice.com/clear- europe/risk-management 

Scroll down to the “ICE Risk Model Overview” section and click the “Download v…” button at the end 
of the section. 
Or simply click this link. 

 
 
6. ICE Risk Model Parameter File(s) 
In order to use IRM to calculate initial margins, the user is required to input two files into the IRM 
tool, the first of which is the risk parameter file (also referred to as the IRM Array file). The IRM Array 
files are available under the risk management section of the respective jurisdiction. For example, ICE 
Clear Europe IRM array files for Energy and F&S products are available under: 
ICE Risk Model Array Files and Margin Rates: https://www.ice.com/clear-europe/risk-management 
Files can be downloaded from the web site via any web browser. Additionally, this web page is stored 
as a favorite within the IRM tool and can be accessed from within the tool by selecting “Favourites” 
and selecting the relevant Clearing House risk arrays. The web page will appear within the tool 
window. 
IRM array files are available for each business day for download. 
The Energy and F&S array files are available in a fixed record format (SP6) and in CSV format (CSV). 
The CSV format file is smaller in size, and it is recommended that this format be used. 
When calculating margin requirements posted by ICE Clear on the morning of the current business 
day the IRM file from the previous business day should be used. Files from historic dates are also 
available. 

https://www.ice.com/clear-europe/risk-management
https://www.ice.com/clear-europe/risk-management
https://www.ice.com/publicdocs/IceRiskModelInstall_x64.msi
https://www.ice.com/clear-europe/risk-management
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NOTE: Save the array file to an easily accessible place on your PC. For use by IRM, it is 
recommended that you save the file to “My Documents\ICE Risk Model\data” as this is the default 
location that the program will look for the array file(s). 
NOTE: When calculating margin for an F&S portfolio you may need more than one IRM Array file. 
For example, if your portfolio contains both FTSE Futures and FTSE Options you will need both the 
“LIF” or “Financial Futures and Options” and “OPT” or “Equity Options” array files. 
Further information about the different formats of IRM array files and the various alternatives for 
obtaining them (including ICE MFT) can be found in the following documents. 
ICE Risk Model Array File Formats 
https://service.ice.com/s/article/ice-risk-model-array-file-formats-23356 ECS, Reporting and MFT 
Technical User Guide https://service.ice.com/s/article/ice-clear-user-guides-22426 
Both documents are published on the ICE Community site. 

Please note you will need to request access to ICE Community to access these documents, you can 
do so from here https://service.ice.com/s/. 

 
 
7. Positions File 
The second file IRM requires as an input, is the positions file. This file needs to be produced by the 
user and uploaded into IRM as either a CSV file or a fixed-format text file. CSV files are preferred as 
they may be easily edited using programs such as Microsoft Excel. 
The following information, by column, is required in the position file: 

A. Position/Trade Flag - this is always P. 
B. Account Name/Identifier - the name of the account (portfolio identifier), this can take 

any value, such as the user's company name. The file may contain positions for multiple 
Account Names; a separate margin figure is calculated for each account. 

C. Exchange Code - “I” for ICE Energy; “L” for Financials; “O” for Equity Options; “X” for 
Commodities; “F” for FX; “G” for ICE Clear Singapore; “N” for ICE Clear U.S.; “T” for 
ICE Clear Netherlands. 

D. Exchange Contract Code - this is the physical commodity code of the contract. 
A full list of the ICE Energy and F&S physical commodity codes are available from the 
following address: https://www.ice.com/products. 
There is a separate set of commodity codes for OTC FX. These are available from the 
OTC FX product guide. 

E. Contract Type - this field can take one of the following values: “F” for futures, “C” for 
call options, “P” for put options, “M” for monthly contracts and “D” for daily contracts, 
and for OTC FX contracts “N” for NDFs. 

F. Expiry Date YYYYMMDD - a year and month is sufficient for futures, for example 
20220400 for April 2022 future. Daily contracts require the DD field to be completed as 
appropriate. For OTC FX this is the final maturity date of the NDF contract. 

G. Strike Price - for futures/NDFs, enter “0” in this field, or leave it blank. For options the 
strike price in ticks is required. For example, for a $75.50 Brent option a value of “7550” 
should be entered, for Gas Oil options “65000” represents a strike price of $650 and for 
ECF options “9500” represents a strike price of EUR 95.00. 
Please note that net liquidation value of options is not included in the calculation of initial 
margins. 

https://service.ice.com/s/article/ice-risk-model-array-file-formats-23356
https://service.ice.com/s/article/ice-clear-user-guides-22426
https://service.ice.com/s/
https://www.ice.com/products
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H. Net Position - the net number of lots the account is long or short within an individual 

contract at expiry date level, a negative sign is required for short positions. Positions for 
options should be netted at strike price level. The IRM tool calculates margin 
requirements on a net basis for positions under the same account in column B. 

 
For OTC FX this is the terms notional amount on an NDF trade. Positive implies you 
are buying the terms currency, negative implies you are selling the terms currency. You 
can enter positions as trades or as net amount by value date for each currency pair 
(commodity code). 

 
Regime and Customer Type – OPTIONAL (N/A for ICUS). The combination of Regime and 
Customer Type (if specified) is used to determine the amount of additional margin that is added to 
the computed initial margin depending upon the type of customer. If no Regime/Customer type is 
specified for a position, no additional margin is added. 

I. Regime 
DCO or RCH (FCMs should specify DCO) 

 
J. Customer Type 

H – Hedger. Use rate applicable to Hedgers 
S – Speculator. Use rate applicable to Speculators 
M – Member. Use rate applicable to Members. 

 
 
Example. Below is an example of a position file created in Excel: 

 

 

Figure 92: Position file example. 
 
 
The position file shown represents a 1 lot long call position in March 2022 EUA options at a strike 
price of EUR 95.00 and a 1 lot long position for April 2022 Brent futures. 
If you use Excel to create the positions, you MUST save the data as a CSV file: 

Click “File” → “Save As...”, then drop down the “Save As Type” box and select “CSV (Comma 
delimited)”. Click “Save”. 

If you create the position file using some other means (e.g., write the positions into a file from your 
own software), you must write the values as comma-separated values. The position file shown in the 
example above would look like the following, if you opened the file in Notepad (for example): 

P,ICE,I,EFO,C,20220300,9500,1 P,ICE,I,B,F,20220400,0,1 
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8. Using ICE Risk Model 
 

8.1. Download ICE Risk Model Parameter File 
The first step, if you have not already done so, is to download the IRM parameter file (IRM array file). 
This can be carried out from within IRM by selecting “Favorites” and selecting the relevant Clearing 
House risk arrays and the download web page will appear within the IRM browser window. 
Select the IRM array file you require and save it locally on your PC; it is recommended that you save 
it to “My Documents\ICE Risk Model\data”. 
See section 6 for further information about IRM array files. 
 
 
8.2. Load Risk Parameters (ICE Risk Model Arrays) 

The next step is to load the IRM array file(s) into the 
application. To load the IRM array file into the application, 
either: 

Select “File” (on the application menu) → “Load Risk 

Parameters” or Click , then “Load Risk Parameters”. 

Navigate to the IRM array file and 
select it. IRM will now load the IRM 
arrays. 

Repeat this step for additional IRM arrays as required. 
NOTE that you can load multiple IRM array files. For example, when calculating margins for a F&S 
portfolio you might need to load the “LIF” or “Financial Futures and Options”, “FOX” or “Soft 
Commodities Futures and Options” and “OPT” or “Equity Options” array files in order to compute 
margin across a portfolio that comprises financials, FTSE Futures, FTSE Options, Equity Options 
and Commodity positions. 
 
 
8.3. Load Position Files 

In a similar manner, upload the position file: 
Select “File” (on the application menu) → “Load 

Positions” or Click , then “Load Positions”. 

Navigate to your position file and 
select it. IRM will now load your 
positions. 

Repeat this step to load further position files. 
 
 
8.4. Calculate Margin 

Once you have loaded IRM Array(s) and position(s) into IRM, it has all the required information 
needed to calculate the initial margin requirement. 
At this point you MUST select the proper setting for the WFPR Cap option. The WFPR Cap option is 
accessed through the Tools menu: Tools→ Apply WFPR Cap. 
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For margining of ICE Energy contracts, this option should be enabled; it should be ticked (see below) 
Now run the margin calculation by either: 

Clicking “Margin” (on the application menu) → “Calculate” or Clicking the  icon. 
 
If your position file contains positions in contracts for which no IRM Array is found, then, these 
positions will be excluded from the margin calculation and warnings will be written to the log file. 
 
 
8.5. Viewing Reports 

Once IRM has calculated the margin requirement, the user can select which reports to generate. You 
can select your chosen reports, by ticking those you require, and generate only those reports by 
selecting “Margin”→ “Report Generation” → “Generate Selected Reports” (or clicking  ). 
Alternatively, selecting “Margin”→ “Report Generation” → “Generate All” will cause IRM to generate 
all reports. 
 
The user is now able to view the reports generated by selecting “View”→ “Reports” → and selecting 

the report you wish to view, or by clicking . 
Report options include: 

• Summary By Margin Group 

• Summary by Combined Contract 

• Summary by Scanning Risk 

• Summary Value Losses 

• Series Value Losses 

• Combined Contract Tier Details 

• Strategy Spread Charge Details 

• Intermonth Spread Charge Details 

• Prompt Date Charge Details 

• Inter-contract Spread Credit Details 

• Expiry Group Delta Details 
Each report will show a breakdown of how a particular charge or credit is calculated.  
For OTC FX, the following reports will be blank, as the IRM set up for these products does not include 
Strategy Spreads, Prompt Date charges etc. 

• Strategy Spread Charge Details 

• Prompt Date Charge Details 

• Expiry Group Delta Details 
 
8.6. Other Options and Functions 
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Various options are accessed under the Tools menu. 
 

8.6.1. Nearest Strike Option 
Under normal circumstances, any position for which no IRM array is found will be ignored during the 
margin calculation process and will generate a warning in the log file. 

However, this behaviour can be modified in the case of options contracts. If your position file contains 
options positions which have options positions with strike prices for which no IRM array is found 
within the IRM array file, then IRM provides the facility, called “Use nearest Strike”, which causes 
those positions to be processed using the array for that strike price closest to that of the position. 
This option is only recommended for intra-day what-if type analysis as it will only give an 
approximation that may not be comparable to the real margin called by the Clearing House at end of 
day. 
Entries will be written to the Log file to record the substitute arrays that were applied. It is the user’s 
responsibility to judge whether this yields an appropriate approximation. 
Note that this is not applicable for OTC FX. 
 

8.6.2. Viewing Log File 
Any errors or warnings issued during any part of the process are output to a log file, the error 
notification will look like the below. The log file may be viewed by selecting “View” → “Log File” on 
the application menu. 

 

 
 
The tool will by default cancel margin calculation when there are over 200 errors in the process, this 
warning threshold can be amended in “Tools” →”Warning Threshold” which may help in 
troubleshooting. 

 
 

8.6.3. Changing results File Name 
You can change the default name of the results file generated by IRM by selecting “Tools” → “Results 
File” and typing a new name in the file name box (default name Results). 
 
 

8.6.4. Changing Warning Threshold 
By default, the processing of margins will stop after 200 warnings have been generated. 
You can change this threshold by selecting “Tools” → “Warning Threshold” and entering a different 
value in the box (default value 200). 
 
 

8.6.5. Delta Split Allocation 
Position allocation is the process whereby the portfolios provided in the position file are transformed 
according to the Position Allocation records within the IRM array file. By default, IRM carries out this 
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process. This can be disabled (not recommended) by disabling this option. 
 

8.6.6. Output Allocated Positions 
To assist in better understanding the Position Allocation process (referred to above), the positions 
that are created as a result of the transformation process can optionally be written to an output data 
file. By default, this file is written to the IRM data directory and is named ppf.csv in “My 
Documents\ICE Risk Model\data”. 
 
 

8.6.7. Apply WFPR Cap 
IRM can constrain the amount of the WFPR used to calculate IRM Inter-Contract Spread Credits 
(Method 10). Whether this capping is applied can be enabled/disabled through this option. 

 
 
9. Using ICE Risk Model in Batch Mode 
An alternative way to calculate margins is by using the command line version of IRM, a program 
called “Marbat” which can be found in the same program directory as IRM; by default, this is 
“C:\Program Files\ICE Clear\ICE Risk Model”. 
Running this program with no command line arguments causes it to output its ‘usage’; a list of all 
command line parameters and options. 
The Marbat command line syntax is as follows: 

Marbat –rf arrayfile [arrayfile2 arrayfile3 ...] –pf positionfile [positionfile2 

positionfile3 ...] [-of outputfilename] [-od] [-ol] [-lf logfilename] [-wt threshold] [-
ws] [-ns] [-wfprcap] [-v] Where items contained in [...] are optional. 

Marbat command line options: 

-rf load the given risk parameter file(s) 
-pf load the given position file(s) 

-of name of output file (optional) - default is 'results.{csv|xml}' 
-od output detailed results (optional) - default is to not output 
-lf name of log file (optional) - default is 'mblog.xml' 
-ol output log file (optional) - default is to not output 
-wt set the warning threshold (optional) - default is 200 
-ws warning stop (optional) - default is to carry on 
-ns use array for Nearest Strike if no array for the actual option strike is available. 
-wfprcap apply capping to WFPR in computation of Method 10 spreads 
-v display version string 

Note that it is assumed that anyone using Marbat.exe is familiar with the Windows Command line 
environment. In the following examples you must substitute “C:\Program Files\
 ...................................................................... \Marbat.
exe” 
with the proper/fully qualified path where the Marbat executable is located; add this path to the “path” 
environment variable; or set default directory to the location etc. You can create a copy of the Marbat 
executable in an alternative location; simply copy Marbat.exe and IceRiskModel.dll to your chosen 
location. 
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Basic usage example: 
C:\Program Files\.....\Marbat.exe ̂  

–pf My_Positions.csv ^ 

–rf IPE0909F.csv ^ 

-wfprcap 

 
The margin results would be written to a file called Results.csv in the default directory. This example 
applies WFPR capping as required for Energy margining. 
A more complex example: 

C:\Program Files\.....\Marbat.exe ̂  

–pf My_Positions.csv ^ 

–rf LIF0909F.csv OPT0909F ^ 

–of myResults –od 

 
In this example two array files are specified (LIF0909F and OPT0909F) and the results are written 
to myResults.csv. In addition, the –od flag means that the detailed XML output is created and this is 
written to myResults.xml. Finally, note that the –wfprcap flag is not specified as this should not be 
specified for F&S products. 
When installed using standard installation settings, Marbat.exe will be found in: 

• For 32 Bit Windows platforms: “C:\Program Files\ICE Clear\ICE Risk Model”; or 

• For 64 Bit Windows Platforms “C:\Program Files (x86)\ICE Clear\ICE Risk Model” 
 
Notes: 

• The name of the output results files may be changed. For example, to rename the output file 
the –of 
option is used as shown below: 
C:\Program Files\.....\Marbat.exe -pf data\Position_file.csv –rf 
data\Parameter_file.DAT -of Renamed_results.csv 

• A more detailed (xml) file of results will be produced if the –od option is used, for example: 
 

C:\Program Files\.....\Marbat.exe -pf data\Position_file.csv -rf 
data\Parameter_file.DAT –od 

 
This will produce a file called ‘results.xml’ in addition to the default ‘results.csv’. 

• A log file can be created using the –ol command; for example: 
 

C:\Program Files....\Marbat.exe -pf data\Position_file.csv -rf 
data\Parameter_file.DAT –ol 

 
This will produce a file called ‘mblog.xml’. 

• Warnings may be issued such as when the margin calculator is unable to locate the risk data 
for a position in a given positions file. The default behaviour will carry on, until 200 warnings 
have been generated. However, by using the –wt option, it is possible to change the setting 
and force the margin calculator to stop once it detects a warning – this is achieved by the –
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ws command. 
 

• If the positions are in more than one file, use the –pl option, giving the name of a file that itself 
contains a list of files. For example: 

 
C:\Program Files\.......\Marbat.exe -pl positions.dat -rf data\IF080423.DAT 

 
If the ‘positions.dat’ file contained the following: 

 
abc.csv def.csv 

 
The margin calculator would load ‘abc.csv’ followed by ‘def.csv’. 

 
The same can be achieved with risk parameter files: the equivalent option if –rl. 

• Finally, it is possible to establish the version of the command line program being used with 
the –v 
option: 

 
C:\Program Files\......\Marbat.exe -v 

 
 
10. ICE Risk Model Margin Report Details 
 
Summary by Margin Group 
The following provides an overall summary of the charges by ICE. For example, for the positions 
entered in the position file the clearing member would have an initial margin of 3,150 EUR plus 7,600 
USD. 

 
 

Figure 103: Summary Margin Report by Margin Group. 
 
 
Summary by Combined Contract 
This gives the summary of all the charges by contract. 
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Figure 114: Summary Margin Report by Combined Contract. 
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Summary by Scanning Risk 
The following gives the final results for each contract, split into the 16 scenarios. It also identifies 
the Largest Loss Scenario and the resultant Scanning Risk. 

 

 
Figure 12: Summary Scanning Risk. 
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Summary Value Losses 
The following is a breakdown of the Scanning Risk calculation for all futures and options per contract, 
giving the results for all 16 scenarios. The results of the delivery month are then summed for each 
contract. The options values are summarised from the Option Value Losses report. 

 
 
 

 
Figure 13: Summary Value Losses. 
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Series Value Losses 
The example below is similar to the Summary Value Losses report, but it breaks down the losses by 
each expiry date. 

 
Figure 14: Series Value Losses. 
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Combined Contract Tier Details 
The example below shows the Net Delta in each Inter-contract tier for each contract. 

 

 
Figure 15: Combined Contract Tier Details BRN. 
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Figure 16: Combined Contract Tier Details ECF. 
 
 
Intermonth Spread Charge Details 
The document below is a breakdown of the Intermonth Spread Charges for the positions held. For 
example, the charge for an intermonth spread with 1 lot long position for Apr 22 Brent Futures and 1 
lot short position for Aug 22 Brent Futures. 
 

 

Figure 17: Intermonth Spread Charge. 
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Inter-contract Spread Credit Details 
This report gives the breakdown of any Inter-contract Spread Credits you may receive for your 
portfolio. In this case, a portfolio with 1 lot long May 22 Brent futures and 1 lot short June 22 WTI 
futures. 

 
 

 
 
Figure 18: Inter-contract Spread Credit. 
 
 
11. Net Liquidating Value 

Net liquidating Value (NLV) is calculated by ICE Clear for all premium paid up-front options, also 
referred to as ‘equity-style options’. For these types of option contracts, variation margin is not paid 
or received on a daily basis, unlike futures-style options. The premium is paid from the buyer to the 
seller of the option when the option is first traded. NLV is calculated as follows: 

NLV = Market price of option x contract size x number of lots 

For more information, please see the NLV description document available from here: 
https://www.ice.com/publicdocs/clear_europe/Net_Liquidating_Value_Guide.pdf 

https://www.ice.com/publicdocs/clear_europe/Net_Liquidating_Value_Guide.pdf
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